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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking in Avaya IP Office 9.1, to interoperate with the Alestra SIP Trunk Service on
the Sonus platform.

The SIP Trunking service offered by Alestra provides customers with PSTN access via a SIP
trunk between the enterprise and the service provider’s network, as an alternative to legacy
analog or digital trunks. This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
trunking between the Alestra SIP Trunk Service, operating on the Sonus platform, and an Avaya
IP Office solution.

In the sample configuration, the Avaya solution consists of an Avaya IP Office 500v2 Release
9.1, Avaya Voicemail Pro and Avaya IP Office soft clients and deskphones, including SIP,
H.323, digital, and analog endpoints.

The Alestra SIP Trunk Service referenced within these Application Notes is designed for
business customers in Mexico. Customers using this service with this Avaya enterprise solution
are able to place and receive PSTN calls via a broadband WAN connection and the SIP protocol.
This converged network solution is an alternative to traditional PSTN trunks such as analog
and/or ISDN-PRI.

2. General Test Approach and Test Results

A simulated enterprise site containing all the Avaya equipment for the SIP-enabled solution was
installed at the Avaya Solution and Interoperability Lab. The enterprise site was configured to
connect to the Alestra SIP Trunk Service via a broadband connection.

The configuration shown in Figure 1 was used to exercise the features and functionality tests
listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.
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2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

Response to SIP OPTIONS queries.

Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital
and analog telephones at the enterprise. All inbound PSTN calls were routed to the
enterprise across the SIP trunk from the service provider.

Outgoing PSTN calls from various phone types. Phone types included SIP, H.323,
digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

Inbound and outbound PSTN calls to/from Avaya Communicator for Windows
softphones.

Various call types including: local, outbound toll free, long distance national and long
distance international.

Codecs G.729A, G.711A and G.711MU.

Fax.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

User features such as hold and resume, transfer, and conference.

Off-net call transfer, call forwarding and twinning.

Items not supported or not tested included the following:

Network Call Redirection using the REFER method is not supported by Alestra and it
was not tested.

Operator services such as dialing 0, 0 + 10 digits and Local Directory assistance are not
supported by Alestra.

Inbound toll-free and emergency calls are supported but were not tested as part of the
compliance test.
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2.2. Test Results

Interoperability testing of the Alestra SIP Trunk Service was completed with successful results
for all test cases with the observations and limitations described below:

Caller ID on outbound calls: On calls originating from IP Office extensions to PSTN
telephones, the caller ID number shown on the PSTN endpoint was always the main DID
number assigned by Alestra to the SIP trunk, not the specific DID assigned to that
extension. This includes calls to “twinned” mobile phones, and calls that were forwarded
or transferred back on the SIP trunk to the PSTN, where the number displayed on the
PSTN endpoint was the main DID number on the trunk, not the originator’s caller 1D.
This may be a requirement of the Alestra service for outbound calls on the SIP trunk; it is
listed here simply as an observation.

Caller ID on incoming calls: On incoming calls made from the test lab in the U.S., the
caller IDs displayed on the enterprise extensions was “Unavailable/Restricted”. This
seems to be a PSTN restriction for international calls to Mexico and not limited just to
Alestra. Inbound calls originating from a test softphone in Monterrey, Mexico displayed
the correct caller ID.

Outbound Calling Party Number (CPN) Block: When an IP Office user activated
“Withhold Number” on an outbound call for the purpose of privacy, IP Office sent
“anonymous” in the “From” header and “Privacy:id”, but on the receiving end at the
PSTN the display still showed the main number assigned by Alestra to the SIP trunk.
This feature may not be supported on the PSTN in Mexico.

Outbound call from an enterprise extension to a busy PSTN number: Alestra did not
send a “486 Busy Here” message on an outbound call to a PSTN number that was busy,
as it was expected on this condition. There was no direct impact to the user, who heard
busy tone.

Fax support: Inbound and outbound fax calls using the T.38 protocol failed during the
test. Fax calls using G.711 pass-through mode were successful while using local PSTN
numbers in Monterrey, Mexico, while they failed on international calls made to and from
numbers in the test lab in the U.S.

Incoming Call, SIP Trunk Signaling Failure: On incoming calls when the SIP trunk is
on a forced “Out of Service” condition, there was no feedback to the PSTN caller, who
just hears silence.
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2.3. Support
For technical support on the Alestra SIP Trunk service offer, visit http://www.alestra.com.mx/

3. Reference Configuration

Figure 1 illustrates the sample Avaya SIP-enabled enterprise solution, connected to the Alestra
SIP Trunk service through a public Internet WAN connection.
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Figure 1: Test Configuration

Note that for security purposes, all public IP addresses of the network elements shown
throughout these Application Notes have been edited so the actual values are not revealed.
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http://www.alestra.com.mx/

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of Avaya IP Office is connected to the enterprise LAN while the LAN2
port is connected to the public IP network. Endpoints include Avaya 1600 and 9600 Series IP
Deskphones (with H.323 firmware), Avaya 1140E IP Deskphones (with SIP firmware), Avaya
1408 and 9508D Digital Deskphones, analog telephones and PCs running Avaya Communicator
for Windows.

The site also has a Windows PC running Avaya IP Office Manager to configure and administer

the Avaya IP Office system, and Avaya Voicemail Pro providing voice messaging service to the
Avaya IP Office users. Mobile Twinning is configured for some of the Avaya IP Office users so
that calls to these users’ extensions will also ring and can be answered at the configured mobile

telephones.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as routers, data
firewall, etc. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that all SIP and RTP traffic between the
service provider and the Avaya IP Office system must be allowed to pass through these devices.
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Component | Version

Avaya

Avaya IP Office 500v2 9.1.100.10
Avaya IP Office Digital Expansion Module 9.1.100.10
DCPx16

Avaya IP Office Manager 9.1.1.0.Build 10
Avaya IP Office Voicemail Pro 9.1.100.3
Avaya 1608 IP Deskphone (H.323) 1.35

Avaya 9640 IP Deskphone (H.323)

Avaya one-X Deskphone Edition
S3.230A

Avaya 1140E IP Deskphone (SIP) 04.04.18.00
Avaya Digital Deskphone 1408 40.0

Avaya Digital Deskphone 9508 0.55

Avaya Communicator for Windows 2.0.3.30
Alestra

Sonus Softswitch V08.04.09R000
Acme Packet SBC V6.2

Lucent SESS V16.1

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2, and also when deployed with all configurations of IP Office Server Edition
without T.38 Fax Service. (T.38 fax is not supported on IP Office Server Edition). Note that IP
Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital

endpoints or trunks.
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5. Configure IP Office

This section describes the Avaya IP Office configuration necessary to support connectivity to the
Alestra SIP Trunk Service. Avaya IP Office is configured through the Avaya IP Office Manager
PC application. From the PC running IP Office Manager, select Start - Programs = IP Office
-> Manager to launch the application. Navigate to File = Open Configuration (not shown),
select the proper Avaya IP Office system from the pop-up window, and log in using the
appropriate credentials.
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A management window will appear similar to the one shown in the next section.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side and the Details pane on the right side. These panes will be referenced throughout the
Avaya IP Office configuration.

Standard feature configurations that are not directly related to the interfacing with the service
provider are assumed to be already in place, and they are not part of these Application Notes.
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5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

In the reference configuration, IP500_Lab2 was used as the system name. Under the system
name on the Navigation pane, select License. Confirm that there is a valid SIP Trunk Channels
license with sufficient “Instances” in the Details pane, enough to support the number of channels
to be deployed on the SIP trunk to the service provider.
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5.2. LAN2 Settings

In the sample configuration, the WAN port was used to connect the Avaya IP Office to the
public network. The LAN2 settings correspond to the WAN port on the Avaya IP Office. To
access the LAN2 settings, first navigate to System (1) under the system name in the Navigation
pane and select the LAN2 = LAN Settings tab in the Details pane. Set the IP Address and IP
Mask fields to the IP address and subnet mask assigned to the Avaya IP Office LANZ2 port. All
other parameters should be set according to customer requirements.

IP Offices
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-2 Contral Unit {4}
[ Extension (47)
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E-@X Short Code (86)
By Service (00
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B4 Incaming Call Route (4
@ WA Port (00
-am Direchary (0)
-1 Time Profile (09
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[l
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On the VolIP tab in the Details pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks on this interface.
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“Lan Settings  ¥oIP |Network Topology |
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The RTP Port Number Range can be customized to a specific range of receive ports for the
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to a UDP
port in the configurable range for calls using LANZ2.

Avaya IP Office can also be configured to mark the Differentiated Services Code Point (DSCP)
in the IP header with specific values to support Quality of Services policies for both signaling
and media. The DSCP field is the value used for media and the SIG DSCP is the value used for
signaling. The specific values used for the compliance test are shown in the example below.

All other parameters should be set according to customer requirements.

LN Settings ~ ¥oIP |Netwnrk Topalogy I

—RTP

—Port Mumber Range

Mimiraum |49152 3: Maxirmum |53246 3:

—Part Mumber Range (NAT)

Mimiraum |49152 3: Maxirmum |53246 3:

¥ Enable RTCP Monitaring on Part S005

RTCP collector IP address for phones ID B | |
keepalives

Scope IDisabIed j Periodic timeout I3U
Initial keepalives IEnabIed j

DiffSery Settings
IBB 3: DSCR(Hex) [B8 = VideoDSCR(Hex) |[FC = DSCP Mask(Hex) |88 == SIG DSCP (Hex)

|46 3: DaCP |46 3: video DSCP |63 3: DSCP Mask. |34 3: 51 D3CP
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. Since no network address translation (NAT) was used in the
compliance test, the parameter was set to Open Internet. With this configuration, settings
obtained by STUN lookups are ignored. The IP address used is the one assigned to the
interface.

e Binding Refresh Time (seconds) is used to determine the frequency at which Avaya
IP Office will send SIP OPTION messages to the SIP trunk using this interface. If this
parameter is left at the default value 0, the IP Office will send OPTIONS messages using
its default interval of 300 seconds. A different value can be used if an interval lower than
300 seconds is needed. In the reference configuration, 180 seconds was used.

e Set Public IP Address to the IP address that was set for LAN2.

e Set Public Port to 5060 for UDP.

e Defaults were used for all other fields.

LAN Settings | voIP  Metwork Topology |

—Metwark Topology Discovery

STUM Server Address IEQ.QD. 168,13 STUM Port |34?8 3:

Firewall/MAT Tvpe IOpen Internet j

Binding Refresh Time (seconds) 150

Public TP Address |1.'-"2 .16 . 157 . 138 Fun ST | Cancel |

Public Port

LDp I 5060 3:

TCP

"

LS

™ Run 5TUM an startup
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5.3. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
SIP trunk to the service provider.

B IP500_Lab2
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I J = A-Law  f-Law Line
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Dial Delay Time (secs) |4 52 ™ Dss status
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[ Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation IDisabIed 'I

v
Phone Failback IManuaI 'I

v

’7Login Code Complexity
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High Cuality Conferencing
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—_—
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5.4. System Codecs Settings

Navigate to the Codecs tab in the Details Pane. The RFC2833 Default Payload field allows the
manual configuration of the payload type used on SIP calls that are initiated by the IP Office.
The default value 101 was used. The list of Available Codecs shows all the codecs supported by
the system, and those selected as usable. The Default Codec Selection area enables the codec
preference order to be configured on a system-wide basis. The buttons between the two lists can
be used to move codecs between the Unused and Selected lists, and to change the order of the
codecs in the Selected codecs list. By default, all IP (SIP and H.323) lines and extensions will
use this system default codec selection, unless configured otherwise for a specific line or
extension.

Click OK (not shown) to save any changes made to any of the various System tabs.
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5.5. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to route calls to the Alestra network.

To create an IP route, right-click on IP Route on the left navigation pane and select New (not
shown).

e Setthe IP Address and IP Mask of the remote subnet where the Alestra SIP Proxy is
located, or enter 0.0.0.0 to make this the default route.

e Set Gateway IP Address to the IP Address of the router on the IP Office subnet used to
reach the external network. For the test configuration, this was the IP address of the local
ISP router.

e Set Destination to LAN2 from the pull-down menu.

e Click OK (not shown) to save any changes.

B oo CIERSGDE
P sk |
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5.6. Administer SIP Line

A SIP line is created to establish the SIP connection between the Avaya IP Office and the Alestra
SIP Trunk service. This line will carry outbound and inbound traffic between, to and from the
service provider.

The recommended method for configuring a SIP Line is to use the template associated with these
Application Notes. The template is an .xml file that can be used by IP Office Manager to create a
SIP Line. Follow the steps in Section 5.6.1 and Section 5.6.2 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.6.3 — 5.6.7.

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New = SIP Line. Then, follow the steps outlined in Sections 5.6.3 —5.6.7.
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5.6.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format.
These XML templates do not include sensitive customer specific information and are
therefore suitable for distribution. The XML format templates can be used to create SIP
trunks on both IP Office Standard Edition (500v2) and IP Office Server Edition systems.
Alternatively, binary templates may be generated. However, binary templates include all the
configuration parameters of the Trunk, including sensitive customer specific information.
Therefore, binary templates should only be used for cloning trunks within a specific
customer’s environment.

1. Copy a previously created template file to a location (e.g., \Temp) on the same computer
where IP Office Manager is installed. By default, the template file name will have the
format AF_<user supplied text>_SIPTrunk.xml, where the <user supplied text> portion
is entered during template file creation.

Note — If necessary, the <user supplied text> portion of the template file name may be
modified, however the AF_<user supplied text>_SIPTrunk.xml format of the file
name must be maintained. For example, an original template file AF_TEST
_SIPTrunk.xml could be changed to AF_Testl_SIPTrunk.xml. The template file
name is selected in Section 5.6.2 to create a new SIP Line.

2. Verify that Template Options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Check the box next to Enable Template
Options. Click OK.

il 1P Office Manager Preferences E E2
“Preferences | Directoriesl Discovery  Wisual Preferences |Security| 'u'alil:latic-nl
Icaon Size ISmaII 'I
¥ mMultiine Tabs
¥ Enable Template Cptions
¥ Enable Template Creation

il QK | Cancel | Help |
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3. Import the template into IP Office Manager. From IP Office Manager, select Tools >
Import Templates in Manager.
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SCM Service User Management
Busy on Held Yalidation

MM Configuration
Print Button Labels

Labz -

IPS00_Lab2

| oicemail | Telephony | Directory Services | Syskem Events I SMTR | 5

|1P5|:|D_Lab2 Locals

Lacation

B2 Control UI'IiL|
[ Extension {4

Import Templates in Manager

e Systern under special control

: User {49)
-ﬂ Group (1)
[-9¢ Shart Code (66)
@ Service (0)

4. A folder browser will open (not shown). Select the directory used in step 1 to store the
template (e.g., \Temp). In the reference configuration, template file
AF_Alestra_ SIPTrunk.xml was imported. The template file is automatically copied into
the default template location, C:\Program Files\Avaya\lP Office\Manager\Templates.

5. After the import is complete, a final import status pop-up window will open stating success
or failure. Click OK.

MAA; Reviewed:
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Note —Windows 7 (and later) locks the Avaya IP Office 9.1 \Templates directory, and it cannot
be viewed. To enable browsing of the \Templates directory, open Windows Explorer, navigate
to C:\Program Files\Avaya\lP Office\Manager (or C:\Program Files (x86)\Avaya\lP
Office\Manager), and then click on the Compatibility files option shown below. The
\Templates directory and its contents can then be viewed.

(-;Q-)v| . = Avaya eSOE {C:) + Program Files (x86) « Avaya = IP Office = Manager - - lm] I Search Manager 1.0
| File Edit Wiew Tooks Help
Organize *  Includeinlibrary = Share with + | Compatibilicy files | Mew Folder = - E:l IZ@:ZI
J TP Office LI Mame ~ Dake modified | Type | Size |ﬂ
. Manager J
| de-DE 1/12/2015 11:20 &AM Fil= folder
| de-DE
L en-Us 1/12/2015 11:20 &M File Folder
. en-Us
s M | es-ME 1/12/2015 11:21 &M File Folder
Fr-FR | frFR 1/12/201511:20 AW File Folder
| IPSET-UNISTIM-C7M . IPSET-UNISTIM-C7M 12f11/2014 4:09 PM File Folder
. IE-IT EIT 1/12/2015 11:20 AM File Folder
) LvMGreeting . L¥MaGreeting 1/12/2015 11:20 AM File Folder
. MemoryCards | MemoryCards 1/12/2015 11:20 &M File Folder
J rHL ! b 1/12/2015 11:20 AM  File folder
Phonell
b Phoneimages | Phonelmages 12/11/2014 .09 FM  File Folder
| pt-BR
| pt-BR 1/12/2015 11:20 &M File Folder
. ru-RU )
|32 099 J ru-RU 1/12/2015 11:21 &M File Folder
| sh-Hans W3z 999 12/11/2014 4:09 PM  File falder
Monitar . zh-Hans 111212015 11:20 AM File folder
. Manager !E

9( )v | . = Local = WirtualStore - Program Files (x86) = Avaya = IP Office = Manager = - lml I Search Manager L]
| File Edt Wiew Tools Help
Organize »  Include inlibrary «  Sharewith +  Mew Folder EE=I 2 E] IZ:.E:ZI
J IP Cffice ;I Mame Date modified ~ | Type | Size |;
. Manager ||
| Templates 4/17/2015 3:15 PM File Folder
de-LF

g( )vl . = VirtualStore = Program Files (x86) ~ Avaya = IP Office » Manager « Templates - lmj I Search Templates 0]

| Fle Edt Wiew Tools Help

Organize *  Includeinlibrary *  Sharewith +  Mew Folder == = E] IZQZI
) 1P Office ;I Mame ~ Date modified | Type | Size |
. Manager
Je-DE = AF_Alestra_SIPTrunk, xml 411712015 3:06 PM #ML Document 4 KB
| e
) en-ls
MAA,; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 36

SPOC 7/2/2015 ©2015 Avaya Inc. All Rights Reserved. Alestra_IPO9_1




5.6.2. Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation Pane, and
select New SIP Trunk from Template.

IP Offices

#- K BOOTP (3) «|| PRI 24 Line |c|-.a.-..-.e|5|
g Operator (3)
(=) IPS00_2 (wSBCE) Line Murnber |Ul
E‘...s-.,_,\, Sy f—
T ;.j 1 Mew 4
ET". |ﬂ Mes SIP Trunk From Template |
----- |
_____ oo B Cut Chri2 Iz =]
----- |58 Copy Chrl+C
""" i Paste Chrly
----- 1| o 351 =
..... #7| /5 Delete Chrl+Del
L
----- T o validate
----- o
_____ I" Connect To, ., Chrl4T Ever j
L
..... o M From Template (Binary) one ﬂ
""" R Change Universal PRI Card Line Type [
----- 11 ;

2. In the subsequent Template Type Selection pop-up window, from the Service Provider
pull-down menu, select the XML template name from Section 5.6.1.

Note — The drop down menu will display the <user supplied text> part of the template
file name (see Section 5.6.1). If the Display All box is checked, then the full template file
name is displayed.

ﬁ Template Type Selection =]

Locale [ Urited States [US Englsh =l

Service Provider | " Digplay All

Create new SIP T runk, | Cancel

Click Create new SIP Trunk to finish creating the trunk.

3. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.6.3 — 5.6.7.
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5.6.3. SIP Line Tab
On the SIP Line tab in the Details Pane, configure (or verify) the parameters as shown below:

e Leave the ITSP Domain Name blank. IP Office will use the ITSP Proxy Address,
defined on the Transport tab on Section 5.6.4, as the host portion of the SIP URI of SIP
headers of messages sent to the network.

Check the In Service box.
Check the Check OOS box.
On the Forwarding and Twinning section, set Send Caller ID to None. This field is not

used in this configuration. On outbound calls, the caller ID number shown on the PSTN
end was always the main number assigned by Alestra to the enterprise, regardless of the

actual number sent in any of the origination headers from the IP Office.
On the Redirect and Transfer section, set Incoming Supervised REFER and

Outbound Supervised REFER to Never. REFER is not supported by Alestra.
e Default values may be used for all other parameters.

B8 SIP Line - Line 17

3IF Line |Transport| SIP LIRII YolIP |T38 Faxl SIP Credentialsl SIP Advancedl Engineeringl

Line Mumber Il? 3: In Service v
ITSP Domain Mame | Check 003 v
URI Type ISIP j —Session Timers
\Eealiiam ICIoud j Refresh Method IAuto j
Timer (seconds) IOn Demand ﬁ
s I —Forwarding and Twinning
Mational Prefix ID Originatar number I
International Prefix IDD Send Caller ID IND“'3 j
Country Code I —Redirect and Transfer
Mame Priotity I System Default j Incoming Supervised REFER INever j
Bresaihiar I Oukgoing Supervised REFER INever j
Send 302 Moved Temporarily r
Outgoing Blind REFER |
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5.6.4. Transport Tab
Select the Transport tab and set the following:

e Setthe ITSP Proxy Address to the IP address of the Alestra SIP proxy server.

e Set the Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2 as configured in Section 5.2.
e Set the Send Port to 5060.

e Default values may be used for all other parameters.

i

= SIP Line - Line 17

S1P Line Transport [s1p LRI volP | 738 Fax | TP Credentials| 1P Advanced| Enginesring|

IT3P Proxy Address |192. 165,145.9

network Configuration

Layer 4 Pratacal fuop x| sendport |[soso =
|se Metwork, Topology Info ILP.N z j Listen Pork ISDED j
Explick DNSServersy |0 . 0o . 0 .o |0 .0 .0 .0

Calls Route via Registrar [V

Separate Registrar I
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5.6.5. SIP URI Tab

SIP URI entries need to be created to match each number that Avaya IP Office and Alestra will
accept on this line. Select the SIP URI tab, click the Add button and the New Channel area will
appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited.

For the compliance test, a single SIP URI was created for calls in the outbound direction. This

SIP URI will populate the user part of the origination headers on outbound calls with the 10 digit
DID number set in the SIP tab of that User, as shown in Section 5.7. The entry was created with
the parameters shown below:

Set Local URI, Contact and Display Name to Use Internal Data. Set PAI to None.

The Registration parameter was set to 0: <None>. The Alestra SIP Trunk service does
not require SIP trunk registration.

Leave the Incoming Group field at the default value 0.

Associate the line to an outgoing line group using the Outgoing Group field. The

outgoing line group number is used in defining short codes for routing outbound traffic to
this line. For the compliance test, a new outgoing group 17 was defined that only contains
this line (line 17).
Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

SIP Line - Line 17

B Remowve

Edit, .,

<

il

O

Zancel

i

Click OK.

Sp Linel Transpart SIP LRI |‘u'u:|IF‘ |T38 FaxlSIF‘ Credentialsl SIP Advancedl Engineeringl
Charinel | Grnuis | Yig | Local URI | Conkact | Disilai Iame | Pl | Cre fdd,
2 17 0 g, 3044 3044 3044 M., o
3 17 0 6., 3045 3045 3045 M., o
4 17 0 6., 3046 3046 3046 M., O
-] 17 0 B, 3047 3047 3047 M., o
& 17 0 6., 3048 3048 3048 M., o

—Edit Channel
Via [172.16.157.138
Local URI IUse Inkernal Data ﬂ
Contack IUse Internal Data j
Display Name IUse Internal Data j
PAI frione |
Registration IIZI: <Mane > j
Incaming Group IU—
Qukgaing Group Il?
Max Calls per Channel Iﬁ
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On inbound calls to the IP Office, Alestra sent in the Request-URI header the last 4 digits of the
dialed DID numbers. In the reference configuration, separate SIP URI entries were created to
match the last 4 digits of each DID number assigned by Alestra to the SIP trunk.

To configure the entries for the SIP URIs for inbound calls, select the SIP URI tab and click the
Add button. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. The example screen below shows a previously configured entry for the DID number with
last 4 digits ending in 3044. The entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to 3044. Set PAI to None.

e Under Registration, select 0: <None> from the pull-down menu.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. For the compliance test, a new incoming group 17 was defined that
only contains this line (line 17).

e Leave the Outgoing Group field with the default value 0.

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern. In the example shown, 2 simultaneous incoming calls are
allowed to this DID number.

e Click OK.

B SIP Line - Line 17

Sp Linel Transpart SIF LRI |'u'l:|IP |T38 Faxl SIP Credentialsl SIP F\dvancedl Engineeringl
Channel | Groups | Wia | Local LRI | Caontack | Display MName | PAIl Cre add,
1 o 17 B.. M., 0=
2 7 ] \ - Remove
3 17 0 6., 3045 3045 3045 M., 0= i
4 17 0 6., 3048 3046 3046 M., 0= Ll
5 17 0 6., 3047 3047 3047 M., -
& 17 0 6., 3048 3048 3048 [ A TH
—Edit Channel
Ok |
Via [172.16.157.138
Zancel
Local URT 3044 | 4|
Contack I3D44 j
Display Name I3D44 j
PAL INnne ﬂ
Registration IIZI: <Mane = j
Incaming Group Il?
Zutgoing Group ID
Max Calls per Channel |2 3:

Repeat the steps above for each DID number assigned by Alestra, to be accepted by the IP Office
on this SIP line.
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5.6.6. VoIP Tab

Select the VolP tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

o
o

SIP Line| Transport | TP LRI YoIP |T38 Fax| SIP Credentials| SIF Advanced| Engineering |

Codec Selection ICustu:um j ™ codec Lockdown
—u d——————— —Selected
nuse sere [ Allow Direct Media Path
6.722 64K == G.729(a) &k CS-ACELP

In the sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit ordered list of codecs to be specified. The buttons allow
setting the specific order of preference for the codecs to be used on the line, as shown.
During the compliance test, G729A, G711A and G711U, in this order of preference,
were the codecs supported by Alestra.

Set Fax Transport Support to G711.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on
the trunk.

Check the PRACK/100rel Supported box, to advertise the support for provisional
responses and Early Media to the service provider.

Default values may be used for all other parameters.

SIP Line -Line 17

™ yalp Silence Suppressian

¥ Re-invite Supparted

G711 ALAW 6K ™| Farce direct mediawith phanes
@711 LLAY 64K

@.723.1 6K3 MP-MLQ
¥ PRACK/100rel Supported

. ™ G.711 Fax ECAN

~5

SJELR

Fax Transport Suppork IG.?ll ﬂ
DTMF Support |RrFczaaa 4
Media Security IDisabIed ﬂ
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5.6.7. SIP Advanced Tab

On the SIP Advanced tab, verify that the Call Routing Method is set to the default selection,
Request URI. On incoming calls, the “To” header arriving from Alestra contained the complete
10 digit DID number dialed, preceded by an 8 digit prefix, while the “Request-URI” header
contained the last 4 digits of the DID number dialed. By making this selection, IP Office will use
the “Request URI” header on the incoming INVITES to route the call to the intended destination,
while the “To” header is ignored in this decision.

For outbound calls with privacy enabled, Avaya IP Office will replace the calling party number
in the From and Contact headers of the SIP INVITE message with “anonymous”. IP Office can
be configured to use the P-Preferred-Identity (PPI) or P-Asserted-Identity (PAI) header to pass
the actual calling party information for authentication and billing purposes. By default, IP Office
will use the PPI header for privacy. To configure IP Office to use the PAI header for privacy
calls, check the box for Use PAI for Privacy.

All other fields retained their default values.

=) SIP Line - Line 17 e -
'51p Line| Transport| ste URi | ote | 738 Fax| S1e Credentials SIP Advanced IEngineeringI
— Addressing 1 Media
Assaciation Method IBy Source IP address j Allow Emply INVITE Il
Send Emphy re-TNYITE I
Call Routing Method IRequest URI j [P
Allow Ta Tag Change r
Suppress DNS SRY Lockups [ P-Early-Media Suppart INone 'l
— Identity Send SilenceSupp=C0ff il
lUse Phone Context r Force Early Direct Media [
#dd user=phane r Media Connection IDisabIed ,l
Preseryation
Use + for International I
Use PAI Far Privacy v
R - — Call Control
s Domain For
Swap From and PAT r Call Initiation Timeout {s) |4 3:
Caller IC from From header r Call Quewing Timeout {m) |5 3:
Send From In Clear - )
Service Busy Response |486 - Busy Here j
Cache Auth Credentials v i
User-fgent and Server I . ggnl\éo User Responding |4UB-Request Timeout j
Headers
Action on CAC Location Inllow Voicemail j

Lirnit

Suppress 0,850 Reason r
Header

Emulate MOTIFY Far r
REFER.

Mo REFER if using r
Diversion

Click OK (not shown) to save any changes made to any of the various “SIP Line” tabs.

No changes were made to the T.38 Fax, SIP Credentials and the Engineering tabs, so they will
not be visited.
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5.7. Users

Configure the SIP parameters for each user that will be placing calls via the SIP line defined in
Section 5.6. To configure these settings, navigate to User in the left Navigation Pane, and select
the name of the user to be modified. In the example below, the name of the user is Extn
1102dcp. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI
in the From and Contact headers for outgoing SIP trunk calls. The example below shows the
settings for user “Extn1102dcp”. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise by Alestra. The SIP Display Name (Alias) parameter can optionally
be configured with a descriptive name.

Click OK (not shown) to save any changes.

IP Offices Extn1102dcp: 1102
& Extension (47) "User | ‘oicemail | DD | Short Codes | Source Mumbers | Telephony I Forwarding | Dial In |
El-g  User (49 i
: (43) Menu Programming | Mability | Group Membership | fnnouncements  SIP Personal Direckory

----- f Maolser

""" i RemateManager SIP Narne [B122823044

----- g'v-r 1857 &y Com RM 1557

----- =1-r 1552 Av Comn SIP 1552 SIP Display Mame (Alias) IExtnl 102dcp

----- 4 1101 Extn1101dep

_____ 1 1102 Extni102dcp Contact |8122823044

----- § 1103 Extn1103dep

----- 4 1104 Extn1104

----- § 1105 Extnit0s [ Ananymaus
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5.8. Incoming Call Route

Incoming call routes map inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc, within the IP Office system. Incoming call routes are defined for each
DID number assigned by the service provider.

To add a new incoming call route, from the left Navigation Pane, right-click on Incoming Call
Route and select New (not shown). The screen below shows the route for one of the DID
numbers assigned to the enterprise by Alestra, 8122823044 in this example.

On the Details Pane, under the Standard tab, set the parameters as show below:

e Set Bearer Capacity to Any Voice.

e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.6.

e Set the Incoming Number to the last 4 digits of the DID number assigned by Alestra.
(3044 in this example). Alestra sent the last 4 digits of the DID numbers in the Request-
URI to the IP Office.

e Default values may be used for all other parameters.

IP Offices =] 17 3044
'"a BOCTP (3) Standard |V0ice Recording | Ciestinations |
----- . Operator (3)
=]
% System {13 Bearer Capability I.C\ny Voice j
“i IPS00_Labz )
T Line (20) Line Graup 10 |1? j
Bl Cantral Unit (4) Incoming Number I3044
[+ Extension (47)
|:|...= User {43} Incoming Sub Address I
[]---éﬂ Group (1) ;
-8 Short Code (56) Incoming CLI |
----- B Service (0)
Locale -
- RS (1) ! =
2/ ] Incoming Call Route () Priotity |1 - Low j
----- BE WaAN Port (0)
----- @ Directary (0) Tag I
. .

-k, 11 Time Profile (0} ) =
[]___@ Firewall Prafilz (1) Hold Music Source ISystem Source J
-l 1P Routs (6) Ring Tone Override INone 4

----- g Account Code (0)

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
8122823044 on line 17 are routed to extension 1102.

17 3044 ’ X v <>

Standard | Woice Recording  Destinations |

TimeProfile Destination Fallback Extensian
P |Default Yalue 1102 Extni 102dcp 4 =]
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5.9. Short Code

In the reference configuration, Avaya IP Office used Automatic Route Selection (ARS) to route
outbound traffic to the SIP line. A short code is needed to send the outbound traffic to the ARS
route. To create the short code used for ARS, right-click on Short Code in the Navigation Pane
and select New (not shown). The screen below shows the creation of the short code 9N used in
the reference configuration. When the Avaya IP Office users dialed 9 plus any number N, calls
were directed to Line Group 50: Main, configurable via ARS and defined next in Section 5.10.

On the Short Code tab in the Details Pane, configure the parameters as shown below.

In the Code field, enter the dial string which will trigger this short code, in this case 9N.
This short code will be invoked when the user dials 9 followed by any number.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix.

Set the Line Group ID to the ARS route to be used. In the example shown, the call is
directed to Line Group 50: Main.

Click OK (not shown).

§ R 0w Shalcoal
1= Cperator (3}
W 1PS00_Lsb2 Code I'ﬂ
w5y Sysen (1)
W IPSO0 Lab2 Featurs [o =]
14 Lre {(20) Telaghona Numiber I,,

ootrol Und {4)

tne Group ID [

:JI
Locelke I 3
Foton Accourt Code r
Foros Msthortostion Code [
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5.10. Automatic Route Selection

While detailed coverage of ARS is beyond the scope of these Application Notes, this section
includes some basic screen illustrations of the ARS settings used during the compliance test.

The following screen shows the ARS configuration for the route 50: Main. The example shows a
subset of the dialed strings tested as part of the compliance test. See Section 2.1 for the
complete list of call types tested. Note the sequence of Xs used in the Code column of some
entries, to specify the exact number of digits to be expected following the access code and the
first digits on the string. This type of setting results in a much quicker response in the delivery of
the calls by the IP Office. The highlighted entries show that for example, for calls in the local
area code, the user dialed 9 plus the 8 digit local number, starting with a 2, which was the range
of local numbers used during the compliance test. For national long distance calls in Mexico, the
user dialed 9, then 01, followed by 10 digit numbers.

£ R poOT? (3) RS |
- ARS Routs 1 I M Sacordary Dl tons
Route Mare l- {;v;twhrn ﬂ ‘
¥ Disl Dedary Tirme [Srsteen Detat (4) = P Ok User Col Barrng
¥ Desarption |
a I Servace v Out of Service Route f-NJw-‘ :]
i Q® '.‘i-t(v‘i"-‘, Cal Rocte (4) |
@ wanpaet (0) Tine Profle [ -] — 0w 0F Motz Rocte B =
on Dwectory (0)
Tarse Syofie (0) l
i @ Frovwad Profie (1)
ol B Rote (5 Coda | Teleghons Number | Festwre | e Groun 1D | I
om Account Code (0) B0 015N [T 17
W Licersa (75) a1 () 1 I
W Turrwl () 2N [2r] 17|
B User Rights (8) 00N [ 1 —j
= ' ARS5(1) B3N 0] 17
¥ 50 Man [T [oF TR
" RAS Location Reguest (0 001N s 17
M Location (D)
R0 Authorigation Code (0) '
N [ [Sove> 3]
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5.11. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration M= E3

—IP Office Settings

IPS00_Labz

— Configuration Rebook Mode
i Merge

" Immediate

" WWhen Free

' Timed

—FRebaoak Time

16:22 =

—Call Barring
r Incoming Calls
r Dutgaing Zalls

(0] 4 I Cancel Help
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6. Alestra SIP Trunking Configuration

Alestra is responsible for the configuration of the SIP Trunk service in its network. The
customer will need to provide the IP address and port used to reach the Avaya IP Office at the
enterprise. Alestra will provide the customer the necessary information to configure the SIP
trunk connection from the enterprise site to the network, including:

IP address of the Alestra SIP Proxy server.

Supported codecs and order of preference.

DID numbers.

All IP addresses and port numbers used for signaling or media that will need access to the
enterprise network through any security devices.

This information is used to complete the configuration of the Avaya IP Office discussed in the
previous sections.

7. Verification Steps

The Avaya IP Office System Status and Monitor applications are useful tools used for the
verification and troubleshooting of the SIP connection to the service provider.

7.1. System Status

The Avaya IP Office System Status application can be used to verify the service state of the SIP
line. Launch the application from Start = Programs => IP Office = System Status on the PC
where Avaya IP Office Manager was installed. Under Control Unit IP Address select the IP
address of the IP Office system under verification. Log in using the appropriate credentials

Online | Offline

Logon

Control Unit IP Address: EERIR-RasR

Services Base TCP Port: [ak=nEl

Local IP Address: WG
User Name:
Password:

M Auto reconnect

. Secure connection
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Select the SIP line of interest from the left pane (Line 17 in the reference configuration). On the
Status tab in the right pane, verify that the Current State is Idle for each channel (assuming no

active calls at

present time).
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Select the Alarms tab and verify that no alarms are active on the SIP line.
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7.2. Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs = IP Office -
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on
the taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office SysMonitor - [STOPPED]
File Edit Wiew Fikers Status Help

=8| »lE[T| x[)

G| e

Start/Stop
Trace

*

Trace

*

Select

Options  Unit

Click the Trace Options icon on the taskbar and select the SIP tab to modify the threshold used
for capturing events, types of packets to be captured, filters, etc. Additionally, the color used to
represent the packets in the trace can be customized by right clicking on the type of packet and

selecting the desired color.
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8. Conclusion

These Application Notes describe the procedures required to configure SIP trunk connectivity
on the Avaya IP Office Release 9.1, to support the Alestra SIP Trunk Service on the Sonus
platform, as shown in Figure 1.

Interoperability testing of the sample configuration was completed with successful results for all
test cases with the exception of the observations/limitations described in Section 2.2.

9. Additional References

[1] IP Office Platform 9.1, Deploying Avaya IP Office Platform IP500V2, Document 15-601042,
April 2015
https://downloads.avaya.com/css/P8/documents/101005082

[2] Administering Avaya IP Office Platform with Manager, Release 9.1, March 2015
https://downloads.avaya.com/css/P8/documents/101005673

[3] Administering Avaya Communicator on IP Office, Release 9.1, December 2014
https://downloads.avaya.com/css/P8/documents/101005862

[4] IP Office Platform 9.1, Using Avaya IP Office Platform System Status, Document 15-601758,
April 2015
https://downloads.avaya.com/css/P8/documents/101005061

[5] Avaya IP Office Knowledgebase
http://marketingtools.avaya.com/knowledgebase

Product documentation for Avaya products may be found at http://support.avaya.com.
Product documentation for Alestra SIP Trunk Service is available from Alestra.
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